Pocket Plates Version 2.5 Release Notes
Includes:
Pocket Plates XP 2.5
Pocket Plates (PDA) 1.7
NOTE: This set of release notes should be used as an update to the previous Pocket Plates
Manual. Because Pocket Plates is not a difficult program to use, we will not update the manual
immediately, but use these notes to update it.
The new version changes both programs; Pocket Plates
XP (formerly known as Pocket Plates Manager) and the
one for the PDA. Pocket Plates XP has had significant
changes as it is now designed for operation in the
aircraft as a plate viewer and navigational assistant. In
prior versions the Plate Manager was mostly for
updating the PDA and printing plates before departure.
The PDA version has had minor changes in
functionality. Most of the changes address prior memory
constraints that limited simultaneous use of Pocket
Plates and AnywhereMap / AnywhereWx.
Pocket Plates XP
Major changes include:
1. Fast airport lookup / loading where diagram is
automatically loaded when approach list is
presented.
2. New interface that allows simple selection of
approach plates and fast switching between plate types (diagram, approach, STAR, DP)
using “Type Buttons”.
3. New interface with icon toolbars that can be repositioned around the perimeter of the plate
display area for more convenient operation.
4. Zoom-to-Fit feature so the entire plate can be viewed in the window as sized.
5. Rotate function so landscape-oriented plates can be viewed without turning your head, the
computer, or the airplane.

Major Changes Detail
1. Fast airport lookup / loading
Loading approach plates for an airport is now simpler than ever before. There are three ways in
which this can be done:
a) Use the map drill down tool. Tap the region, state, city, etc. until the list of
approaches is presented. This function has not changed form prior versions.
b) Tap the airport symbol.
Tap Destination (requires AnywhereMap / AnywhereWx to be
running with a flight plan loaded). The list of approaches for the
destination airport in AnywhereMap will be presented.

c) Tap the airport symbol.
Tap in the airport identifier (do NOT
use the “K” prefix). The list of
qualifying airports automatically adjusts
as you type each letter. Once the airport
of interest is seen on the list, tap its
identifier. The list of approaches for that
airport is now presented.

Tap characters here…

Tap STL for St. Louis

Once the list of approaches is presented, tap the approach you want to
view. If the airport you’ve selected has a full-page airport diagram, that
diagram will have been loaded automatically under the diagram Type
Button.
Tap the approach you have been assigned. The approach plate will
display in the viewer.

2. New Approach Type Buttons
There are four new buttons on the tool bar that correspond to approach “types”. We are
not referring to types as in VOR, NDB, or ILS. Instead we are referring to the Airport
Diagram, Approach, STAR (arrival), and DP (departure).
The new buttons are shown in order of listing at right. Once a plate has been selected
under each button, you can switch from one type to the next very quickly by simply
tapping on the button that represents the type.
For example, once you tap STL in the airport lookup listing, the airport diagram for STL
is automatically loaded under the Airport Diagram type button. You are automatically presented
with the Approach listing, on which you select which approach you have been assigned.
If you tap the ARV button, the list of Arrivals for that book (the NACO book in which the airport
plates are printed). Simply tap the arrival you have been assigned and the arrival (STAR) plate is
loaded in the viewer.
If you tap the DEP button, the list of Departures for that airport at listed. When you tap the
departure of choice, the departure plate is loaded in the viewer.
Switching between the Approach plate, Arrival plate, Departure plate, and Airport Diagram is as
simple as tapping the associated Type button.
Notes and Important Reminders:
a) Not all airports have an airport diagram on a separate page. Many smaller airports’ diagrams
are displayed in the lower right or left corners of each approach plate. In this case, no diagram
will be found under the diagram type button.
b) Pocket Plates uses the indexing of plates, STARs, DPs, and diagrams as provided by the
FAA’s NACO plate set. NACO does not publish an index for arrivals as they apply to a specific
airport. Instead, they publish the arrival list for the region covered within the book in which that
airport is found. For example, if you are looking at plates that are found in the NACO book that
covers Nebraska and Kansas, then the Arrivals for Nebraska and Kansas will be found in that
book, not associated with each airport, but listed in the front of the book. When you look at a
specific airport and then view the STAR list, the list covers the entire book and may or may not
apply to the airport you are viewing.
c) If you are viewing an Approach plate (i.e. you pressed the approach type button) and you
press the Approach type button again, the list of approaches will re-appear, allowing you to
select a different approach. This holds true for all the Type buttons except for the Airport
Diagram.

3. New Toolbars
The toolbars have been redesigned to be more intuitive and also for easy repositioning around
the perimeter of the display area. This helps maximize plate viewing on various units that have
different screen configurations, landscape or portrait.
Buttons down the left side

Buttons across the top

4. Zoom-to-Fit
We have added the ability to view the entire plate in the window regardless of window
orientation or sizing. To do so, simply tap the Zoom-to-Fit button to toggle between the 1:1 view
(left image below) and the Zoom-to-Fit view (right image below). Zoom-to-Fit makes sure the
entire plate can be seen in the window in correct proportion, so there may be large amounts of
white space in the view.

5. Rotate Plate Function
Some Airport Diagrams, STARs, and DPs are oriented in landscape instead of portrait.
This means that their initial presentation is 90 degrees from upright viewing when the
plate is first displayed. The Rotate button now allows you to rotate the plate to the proper
viewing orientation.

Notes:
a) Rotate plate works for all types, but at the current time this rotated orientation does not remain
if you change viewing to another type and then return.
b) You can tap around the center of the viewing area when the plate is rotated just like you can
when the plate is viewed without rotation. If you view another type and then return, the view
position will not be remembered and you will have to re-tap it to the desired position. This will
also be changed in an upcoming version.
6. Left / Right Arrow Buttons
The blue left/right arrow buttons allow you to step through the list of approaches without
selecting from the list. This is especially handy when you are viewing a STAR or DP that has
instructions on the following page. To see the second page, just tap the right arrow. To back up,
tap the left arrow. Continuing to press the right arrow will step you through the rest of the pages
in that list.

7. Book Mode
Book mode still exists even though the STARs and DPs are easier to retrieve using the new Type
buttons. You can activate Book Mode by either right clicking on the screen and selecting the
section of the book you want to review or by tapping View > Book Mode.
Book Mode contains the info that is in the front of each book including legends, performance
tables, Alternate and Takeoff minima, etc. Use the blue arrow buttons to move page by page
through the section. To close the book mode and revert to the approach, STAR, DP, or diagram
you were viewing before you initiated Book Mode, simply tap the red “X” button.
8. Calibration
Nothing has changed in the calibration of the plates. The Ruler icon on the toolbar initiates the
calibration process. Here are a few reminders:
a) ONLY use fixes, VORs, NDBs, etc. that are WITHIN the 10 NM circle. Items outside the
circle are NOT to scale and using them will cause the calibration to be inaccurate.
b) You must complete the calibration and have a GPS connection secured before your position
will display on the plate.
c) To set the GPS, go to File > Configure > GPS Setup. If you have AnywhereMap or
AnywhereWx, set the GPS to “Shared”. If you do not have those programs, then set the GPS to
“Use attached GPS….” and set the COM port to the one used by your GPS.
9. Installation
Pocket Plates XP installation now allows you to specify where on your computer you want the
plate files to be installed. You do not have a choice about the application files but they do not
consume much space. The plate files for the entire US, however, consume between 700 Mb and
800 Mb of space. You may want to place them in a different storage location.
Hints:
a) If you have a tablet computer with a large hard drive (for example, greater than 3 or 4 Gb
available) then allow the installation to place the files in the default directory: C:\DLFiles\Plates.
b) If you have a tablet computer with limited space (such as those with smaller solid-state drives)
but your computer has a removable storage card slot (such as Secure Digital (SD) or Compact
Flash (CF)), then insert a storage card and specify that “drive” number (D, E, F, etc.) for plate
installation.

10. Updates
Updates have not changed from prior versions. The procedure for updating is as follows:
a) Connect your tablet / computer to the Internet
b) If you also have a PDA that you use for displaying Pocket Plates, connect it to the computer
and make sure Active Sync has finished synchronizing.
c) Verify that your username and password have been entered into the proper settings boxes by
tapping File > Configure > Set Username / Password. They are case sensitive.
d) Press the button labeled Web Update. It is the icon that has the computer on it, not the one that
shows the smaller PDA.
e) If you have plenty of storage space (or if the entire US has already been loaded) then use the
“Update All Plates” button. Otherwise select the “Update using Filters” and set the filters as you
require. Once completed, you may be asked whether you want to update the PDA. If you have
one, tap Yes. If not tap No and the update is complete.
f) If you are updating the PDA, check out the directions in the original manual for the details on
updating it or the storage card it uses.
11. Night Mode
You now have a Night Mode button to press that reverses out the plate from black text
on white to white text on black.
Known Issues with Pocket Plates XP
1. Plate orientation (including position and rotation) is not saved when you switch from one
Type to another. This will be corrected in an upcoming release.
2. Night mode does not reverse the tool bar unless AnywhereMap or AnywhereWx us running
and is also in Night Mode.
3. Calibration data points may not remain in the proper position when you Zoom-to-Fit or rotate
the plate.

Pocket Plates for PDA 1.7
What’s New:
1. Lower memory consumption, which allows it to work with AnywhereMap simultaneously.
2. Improved plate calibration
3. Day / Night Mode
Major Changes in Detail
1. Lower memory consumption
This version has been updated to be much more efficient with memory use during plate display.
This will allow Pocket Plates to once again work simultaneously with AnywhereMap or
AnywhereWx.
Before you install this version, you MUST have either an Secure Digital (SD) or Compact Flash
(CF) storage card installed in your PDA’s slot. The new version will offer to move your database
files from the main memory of the PDA to the storage card so that all possible memory will be
available to run the plates. You should answer “yes” to the question about maximizing the
memory availability. This is especially critical for running AnywhereWx at the same time!
2. Improved plate calibration
Now when you calibrate a plate, only the fixes associated with the airport will be displayed in the
list for selection. Before, all fixes in the area were listed whether associated with the airport or
not making the list long and more difficult to navigate.
3. Day / Night Mode
The plates can be reversed (white text on black background) for night time viewing. This reduces
the overall light output of the PDA and improves night vision.
Known Issues

